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1 Introduction

This program was written at Daresbury Laboratories using the LabWindows/CVI development package from National Instruments.  LabWindows is really aimed at instrumentation development, and although this program has nothing to do with instrumentation, the user interface development facilities and the C environment of LabWindows have been used.

It is aimed at providing facilities to convert input data files of a certain format, usually binary or raw ASCII data files, to output data files of another format, usually a format suitable for use in another data analysis application.

This program’s facilities were first requested by a number of users of Daresbury Laboratory.  Their motivation was that manually converting the diffraction data files produced on Daresbury’s stations by cutting and pasting was tedious, especially when having to convert hundreds of data files manually!

With an easy to use graphical user interface, and a good batch processing ability, this program provides a quick and efficient way of converting multiple data files.

Organisation of this manual
· Section 2 – Installing DL Converter

This section is a guide to installing the DL Converter program.

· Section 3 – User Guide to DL Converter

This section is a guide to using the actual DL Converter program.

· Section 4 – DL Converter Demonstration

This section uses screen shots to give you a brief guide to performing a typical conversion in DL Converter.

· Section 5 – Technical Description

You will probably not need to read the “Technical Description” section of this manual as it describes the programming elements of the program and is not important for learning how to use this program.

· Section 6 – Appendix

An appendix has been included at the end of the manual giving detailed descriptions of the file formats supported in the program.  This may be useful for examining and comparing your data files. 

2 Installing DL Converter

DL Converter has been built under LabWindows/CVI as a 32-bit application to be run under the Windows 95 operating system.

Distribution Disks
Installing DLConverter

If you are installing the program from distribution disks, follow these instructions :

1. Insert the distribution floppy disk into drive a:

2. Click on the “Start” button on your toolbar and select “Run”.

3. Type a:\setup.exe and press return.

4. You will then be asked to type in the destination directory to install the program.  This should be, and will be defaulted to, C:\DLConverter.  In order for the program to work, the LabWindows/CVI Run-Time Engine must also be installed.  Depending on the setup of your distribution kit, the run-time engine will either be included as part of your distribution kit, or will have to be installed separately.  If the run-time engine is included in your distribution kit, you will be asked to type in the destination directory to install it.  This should be, and will be defaulted to, C:\cvirte.  If you have to install the run-time engine separately, see below for details.

5. The installation program will then install DLConverter on your system.  To load DLConverter click on the “Start” button on your toolbar and select “Programs” and “DLConverter”.

Installing the LabWindows/CVI Run-Time Engine
If you are installing the LabWindows/CVI Run-Time Engine separately from floppy disk, follow these instructions :

1. Insert the distribution floppy disk into drive a:

2. Click on the “Start” button on your toolbar and select “Run”.

3. Type a:\setup32.exe and press return.

4. You will then be asked to type in the destination directory to install the run-time engine.  This should be, and will be defaulted to C:\cvirte.

5. The installation program will then install the run-time engine on your system.  With this installed, you can run any application developed under LabWindows/CVI.

Downloading the Program
DLConverter can also be downloaded from the Daresbury Laboratory web page.

The program can be found at the following address :

Old: http://www.dl.ac.uk/CCP/CCP14/projects/dl-conv/

New: http://www.ccp14.ac.uk/projects/dl-conv/

3 User Guide to DL Converter

3.1 Main Panel
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This is the main panel of the program and is where the setting up of a conversion takes place.  This panel consists of three main areas :

· The file selection area.

· The main panel controls.

· The menu bar.

3.1.1 File Selection Area

The list box in the file selection area is where any files that have been opened appear.  (To open a file you must click on “Open” from the main menu bar and click on one of the input file formats of your choice.)  When the files are first opened they appear in the list box without a check mark.  A file must be checked in order for it to be eligible for a conversion.  To check mark a file you must either click on the actual file name in the list box, or click on the “Select All” command button below the list box to put a check mark against all of your opened files.

The list box has a vertical scroll bar so that you can look up and down the file selection.

Any subsequently opened files are appended to the list.

NOTE : Only one type of input file format can be opened at any one time.  Therefore, for example, if you have a number of SRS data files in the list box and you then open some Argonne data files, the SRS filenames will disappear and will be replaced by the Argonne filenames.

3.1.2 Main Panel Controls

Select All

Clicking on this command button below the file selection list box will put a check mark next to all of the files that you have open in the list box (if any).

A single file can be checked by simply clicking on its name in the file selection list box.

Deselect All

Clicking on this command button below the file selection list box will remove all of the check marks (if any) from the files that you have open in the list box.

A single file can be unchecked by simply clicking on its name in the file selection list box.

Remove All

Clicking on this command button will remove all filenames from the file selection list box (if any).  This means that you no longer have an input file format selected and this will be shown on the “Current Input Format” indicator as “None”.

Reset

Clicking on this command button will reset the present list box to display the opened files previously selected by the user in order to allow a new conversion if needed.
Convert

Clicking on “Convert” will begin a conversion.  It performs the same operation as clicking on the “Convert” menu item from “File” on the main menu bar.  A conversion will take place as long as four operations have been performed:

1. An input type must have been selected.  In order for an input type to be selected, you must open at least one input file from the main menu bar.  The current input format is displayed on the “Current Input Format” indicator on the main panel.

2. At least one of the opened files inserted into the file selection list box must have been checked.  This can be done by either clicking on the file name in the list box itself, or by clicking on the “Select All” command button.  All of the file names that have been checked will be converted.

3. An output type must have been selected.  In order for an output type to be selected, you must click on one of the “Select Output Format” toggle buttons.  Obviously, only one of these toggle buttons can be toggled at any one time.  The current output format is displayed on the “Current Output Format” indicator on the main panel.

4. A conversion type must have been selected. In order for a conversion type to be selected, you must click on one of the “Conversion Format” toggle buttons. The current conversion format is displayed on the “Current Conversion Format” indicator on the main panel.

When these four initial operations have been satisfied, a conversion can begin.  You may be asked to select an output directory or an output filename from a popup panel depending on which conversion you are performing and which options you have set.

Options…

This command button performs the same operation as selecting one of the output formats from the “Options” menu item on the main menu bar.

In order for this command button to be used properly, you must first of all toggle one of the output format toggle buttons on the main panel (“Select Output Format”) and toggle one of the conversion format toggle buttons on the main panel (“Select Conversion Format”).

Note: You MUST select both toggle buttons (Output and Conversion Format) in order to display the right options panel and to be able to convert the selected files.

“Select Output Format” toggle buttons

Clicking on these toggle buttons either selects or deselects an output format.  The current output format is displayed on the “Current Output Format” indicator on the main panel.

Only one type of output file format can be selected at any one time.

When an output format has been toggled, you can click on the “Options…” command button on the main panel to bring up the options box for that particular output format.

NOTE : Sometimes, a number of the output format toggle buttons will be hidden.  This happens when a number of input files have been opened which do not support a conversion to that particular output format.  E.g. A conversion from MCA format to Xfit format is not supported.  Therefore, if a number of MCA input files have been opened, the Xfit output format toggle button will be hidden indicating that you cannot perform this conversion.

“Conversion Format” toggle buttons

Clicking on these toggle buttons either selects or deselects a conversion format.  The current conversion format is displayed on the “Current Conversion Format” indicator on the main panel.

Only one type of conversion format can be selected at any one time.

When an output format and a conversion format have been toggled, you can click on the “Options…” command button on the main panel to bring up the options box for that particular output format.

NOTE : Sometimes, a number of the output format and conversion format toggle buttons will be hidden. This happens when a number of input files and an output format have been selected which do not support a conversion to that particular conversion format.

For instance, a conversion from Argonne format and a CPI output format to Dspacing is not supported. Therefore, if a number of Argonne input files have been opened and the CPI toggle button has been toggled, the Dspacing (and Two-Theta) conversion format toggle button will be hidden indicating that you cannot perform this conversion.

“Current Input Format”, “Current Output Format” and “Conversion format” Indicators

These indicators speak for themselves.  They act as a reminder for what input, output and conversion formats are currently selected.  If no formats have been selected, these indicators will display “None”.

Quit

Simply quits the program.  The user is asked to confirm the termination of the program.

3.1.3 Menu Bar Items

The main menu bar contains the following items :

· File

· Options

· Rebinning

· Extension

· Help

The version 1.2 includes two new more items which are rebinning and extension. These new items will be described later on in this part.

File

The “File” menu item contains the following items :

· Open

· Convert

· Print Log File

· Quit

File->Open

Clicking on this menu item will bring up another menu item box with all of the input file formats supported by the program.  Click on one of these to open that type of file.  This will display a file select popup panel (shown below) where you can select any number of files of that particular type.
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This is a typical Windows file select popup panel.

Select the input files by clicking on their names and then clicking on the “Add” command button.  This will put the file in the “Selected Files:” box at the bottom of the panel.

You can select multiple files at once by holding down the <Ctrl> key on the keyboard and clicking on the file names with the mouse.

Alternatively you can click on a file name with your mouse, then hold down the <Shift> key on the keyboard, and click on another filename with your mouse.  This will highlight all of the files between the first file that you clicked on and the second file.

To remove the selected files, you can either click on the “Remove All” command button to remove all of the selected files, or you can first of all highlight a file name in the selection box and then click on the “Remove” command button to remove just that file.

Click on “OK” to open the selected files or click on “Cancel” to cancel the operation.

NOTE : Depending on the input file format that you have requested, the file names that will be offered for selection on the panel will have their file extensions restricted to the file extension of that particular file.  E.g. if you have chosen to open an MCA file, your files will be restricted to those with a *.chn file extension.

File->Convert

Clicking on this menu item performs the same operation as clicking on the “Convert” command button from the main menu.  To find out more see the section on “Main Panel Controls”.

File->Print Log File

Clicking on this menu item will print the conversion log file to your printer.

The log file (named “log.dat”) is maintained by the program and should be located in the project directory.  The log file contains a list of all of the files that have been converted by the last conversion attempt.

File->Quit

Simply quits the program.  This menu item performs the same operation as clicking on the “Quit” command button from the main panel.

Options

The “Options” menu item contains the following items :

· Xfit (Energy) Options…

· Dspacing or Two-Theta Options…

· SRS Options…

· CPI Options…

Options->Xfit (Energy) Options…

Clicking on this menu item displays the Xfit options panel.  See the section “Xfit Options Panel”.

Options-> Dspacing or Two-Theta Options…

Clicking on this menu item displays the Dspacing or Two-Theta options panel.  See the section “Dspacing or Two-Theta Options Panel”.

Options->SRS Options…

Clicking on this menu item displays the SRS options panel.  See the section “SRS Options Panel”.

Options->CPI Options…

Clicking on this menu item displays the CPI options panel.  See the section “CPI Options Panel”.

Rebinning

The “Rebinning” menu item contains the following options:

· No rebinning

· Two datapoints to one

· Four datapoints to one

This new option allows the user to decide the kind of data rebinning. There are three different options and only one can be chosen at any one time. The option with a check mark will be taken into account during the conversion. You can change the kind of data rebinning by simply clicking on the one you want. In that case, your choice will be checked by a check mark and the previous option will be unchecked.

NOTE : There is no “OK” button to confirm your choice. The check mark close to the kind of rebinning will be taken into account during the conversion. Also, at the moment, no rebinning option is allowed if a MCA file has been selected, the option “No rebinning” will be automatically checked and all the options hidden.

Rebinning->No rebinning

Clicking on this menu item will not rebin the data of the input files. As a default, this option is already checked by a check mark.

Rebinning->Two datapoints to one

Clicking on this menu item rebins the data of the input files from two datapoints to one. Every two values are summed and divided by two to give the average of these two values.

Rebinning->Four datapoints to one

Clicking on this menu item rebins the data of the input files from four datapoints to one. Every four values are summed and divided by four to give the average of these four values.

Extension
The “extension” menu item contains the following options:

· .Xy

· .Prn

· .Txt

As a default, this menu item is hidden and no changes are allowed. The options of this menu are available only when you toggled “Energy to Dspacing” or “Energy to Two-Theta” toggle buttons from the “conversion Format”.

The check mark close to the extension you want will be taken into account during the conversion.

Extension->*.xy

Clicking on this menu item checks and selects the *.xy extension.

Extension->*.prn

Clicking on this menu item checks and selects the *.prn extension.

Extension->*.txt

Clicking on this menu item checks and selects the *.txt extension.

Help

The “Help” menu item contains the following options:

· Overview

· About

Help->Overview

Clicking on this menu item will bring up a dialogue box with a little information about the program.

Help->About

Clicking on this menu item will display an “About” panel which displays some information about the program, such as the author, where it was written, copyright information, etc.

3.2 Xfit (Energy) Options Panel

[image: image2.png]Column Format

e A Value (Xiit Start)

 Single Column 00000000000

10 Column Output
B Value (Xfit Step]

00000000000

Change Data Values|

© AddTloAIVaes 7
 NoChange





This is where the Xfit options are chosen.  The screen shot above shows the option defaults.  When “OK” is clicked on, any options that have been toggled will be registered.  If “Cancel” is clicked on, any options that you may have changed will be ignored.

Description of options :

· Column Format

Same as Input

Having this option toggled means that the data converted in the output file will have exactly the same column format as the input file.

Single Column

Having this option toggled means that the data converted in the output file will be in a single column.

10 Columns Output

Having this option toggled means that the data converted in the output file will be in ten columns.

· Change Data Values

Add 1 to All Values

Having this option toggled will add 1 to every converted value in the output file.  This is necessary in Xfit because any data value of zero causes Xfit to crash.  Therefore, in case there are any zero data values in your input file, this option will prevent Xfit from falling over and is recommended.

No Change
Having this option toggled simply means that the data values will remain unchanged (1 will not be added to the data values).

· A Value (Xfit Start)
Calibration constant.  This is the initial value of the angle, energy or channel and is inserted into the Xfit data file header.  A 'Stop' value is also inserted into the Xfit data file and is calculated from the 'Start' and 'Step' values using the equation :

(Step * (#values - 1)) + Start.

· B Value (Xfit Step)
Calibration constant.  This is the value by which every count is incremented on the x-axis and is inserted into the Xfit data file header.  A 'Stop' value is also inserted into the Xfit data file and is calculated from the 'Start' and 'Step' values using the equation:

(Step * (#values - 1)) + Start.

3.3 D-Spacing or Two-Theta Options Panel
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This is where the D-Spacing or Two-Theta options are chosen.  The screen shot above shows the option defaults.  When “OK” is clicked on, any options that have been toggled will be registered.  If “Cancel” is clicked on, any options that you may have changed will be ignored.

Description of options:

· Change Data Values

Add 1 to All Values

Having this option toggled will add 1 to every converted value in the output file.  This is necessary because any data value of zero can cause D-Spacing or Two-Theta to crash.  Therefore, in case there are any zero data values in your input file, this option will prevent D-Spacing or Two-Theta from falling over and is recommended.

No Change
Having this option toggled simply means that the data values will remain unchanged (1 will not be added to the data values).

· A Value (Xfit Start)
Calibration constant.  This is the initial value of the angle, energy or channel and is inserted into the D-Spacing or Two-Theta data file header.  A ‘Stop’ value is also inserted into the D-Spacing or Two-Theta data file and is calculated from the ‘Start’ and ‘Step’ values using the equation:

(Step * (#values – 1)) + Start.

· B Value (Xfit Step)
Calibration constant.  This is the value by which every count is incremented on the x-axis and is inserted into the D-Spacing or Two-Theta data file header.  A ‘Stop’ value is also inserted into the D-Spacing or Two-Theta data file and is calculated from the ‘Start’ and ‘Step’ values using the equation:

(Step * (#values – 1)) + Start.

· Angle of detector
Calibration constant. This is the value of the angle of detector by which the value of the D-Spacing or Two-Theta will be calculated. This value is set as a default to 10 degrees and must be between 0 and 90 degree.

· Headers Options

Without header
Having this option toggled simply means that the data values will have a header and the information of the other options will be displayed.

With header

Having this option toggled simply means that the data converted in the output file will not have a header. The other options of the panel will not be displayed in the output file.

3.4 SRS Options Panel
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This is where the SRS options are chosen.  The screen shot above shows the option defaults.  When “OK” is clicked on, any options that have been toggled will be registered.  If “Cancel” is clicked on, any options that you may have changed will be ignored.

Description of options :

· Output Files
Single File
With this option toggled, the output will be one single file (i.e. all of the input files will be appended into one single output file).

Multiple Files
With this option toggled, the output will be multiple files (i.e. all of the input files will have their own corresponding output file).

3.5 CPI Options Panel
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This is where the CPI options are chosen.  The screen shot above shows the option defaults.  When “OK” is clicked on, any options that have been toggled will be registered.  If “Cancel” is clicked on, any options that you may have changed will be ignored.

Description of options :

· Change Data Values

Add 1 to All Values

Having this option toggled will add 1 to every converted value in the output file

No Change
Having this option toggled simply means that the data values will remain unchanged (1 will not be added to the data values).

· A Value (CPI Start)
Calibration constant.  This is the initial value of the angle, energy or channel and is inserted into the CPI data file header.  A 'Stop' value is also inserted into the CPI data file and is calculated from the 'Start' and 'Step' values using the equation :

(Step * (#values - 1)) + Start.

· B Value (CPI Step)
Calibration constant.  This is the value by which every count is incremented on the x-axis and is inserted into the CPI data file header.  A 'Stop' value is also inserted into the CPI data file and is calculated from the 'Start' and 'Step' values using the equation :

(Step * (#values - 1)) + Start.

· Select an option

Wavelength

With this option toggled, the user will be able to set the value of the wavelength (if needed). This value corresponds to the angular dispersive and will be inserted in the header of the CPI files.

Angle of detector

With this option toggled, the user will able to set the value of the angle of detector (if needed). This value corresponds to the energy dispersive and will be inserted in the header of the CPI files.

Not known
This value is defined as default to a junk value 1. This option is required when the user does not know the wavelength or the angle of detector value.

3.6 Progress Panel
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When a conversion begins, the main panel is hidden and the progress panel is displayed.

The progress panel shows information about the current conversion.  The “Current Input Format” and “Current Output Format” indicators show the type of conversion which is in progress.

The box below the indicator shows the current input file that is being converted and what outputs file it is being converted to.  This is constantly updated so that you can watch the conversion in progress.

The conversion can be cancelled at any time by clicking on the “Cancel” command button.  You will be asked to confirm the cancellation.

NOTE : you may have to wait for the current file to finish being converted before cancelling.

3.7 About Panel
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The “About” panel simply displays some information about the program, such as the author, where it was written, copyright information, etc.

Clicking on “OK” will remove the panel from the screen.

DL Converter Demonstration

What follows is a demonstration run of DL Converter to convert Daresbury SRS Station 16.4 data files to CPI format :

· First of all you must open at least one input file.  For this example we are converting SRS data files, so click on “File” from the main menu bar, then “Open”, “SRS Format”.
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· A multi-file select popup panel will then appear asking you to select the input SRS data files that you wish to convert.  Select as many files as you want and click on the “Add” command button to add them in and click on “OK” when you have finished.
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· You will then be returned to the main screen where your selected files will have been inserted into the “Current File Selection” list box.  Notice how “SRS” has now appeared on the “Current Input Format” indicator.  In order for these opened files to be eligible for conversion they must all be check marked.  The quickest way to do this is by clicking on the “Select All” command button on the main [image: image7.png]@ DL Converter (Version 1.2) [_[C1x]
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· Before beginning the conversion, make sure that you have selected the correct output format and the correct options.  In this case we want to convert to CPI format, so click on the “CPI” toggle button under “Select Output Format”.  Next you need to change any options that you require.  To bring up the CPI Options panel, click on “Options” from the main menu bar and then “CPI Options…”, or click on the “Options” command button on the main panel (this will only work if you have toggle the “CPI” output format radio button).  Choose your options and click on “OK” to set any changes.
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NOTE : If the user entered a negative value for A Value or B value then a warning message panel will be prompted. The respective warning message will be displayed and the user could carry on with those values or then come back to the CPI options panel. The same will appear with the wavelength or the angle of detector value. This value must be positive and between 0 and 180 degree.
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· You are now ready to start the conversion so click on “Convert” on the main panel.  In the case of converting to CPI format, you need to select an output directory to store the converted files.  A “Select Output Directory” popup panel will appear where you must double-click on your directory so that it appears in “Directory History:”.  Click on “Done” to confirm this.
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· The conversion will now begin and the progress panel will appear.  Notice the “Current Input Format” and “Current Output Format” indicators are showing the current conversion type and the progress box below lets you see the conversions happening.
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· DL Converter will then tell you when the conversion has finished.
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NOTE : DL Converter will automatically detect when the stop value, calculated from the A and B values of the CPI options panel, will be greater than 180. Then, a warning message will be displayed to the user to advise him that the converted files will create problems running software as X-Plot. The conversion will be done anyway.

This is due to the fact that anything above 180 degrees is physically unreasonable, as angular dispersive diffractometer cannot go to 180 degrees.

· After clicking on ‘OK’ you will come back to the main panel. DL Converter will then prompt if your selected files have been converted as a single file or as a multiple file.

NOTE : The button ‘Reset’ is now available to allow the user to come back to the previous main panel in order to do an another conversion if needed. The ‘Convert’ button will be dimmed until ‘Reset’ as been clicked.
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4 Technical Description

4.1 Module Overview
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The above picture shows an overview of the modules and their dependencies in the system.

The run time files for the application consist of an executable file and a User Interface Resource file (.uir), both of which have been created using LabWindows/CVI.  The User Interface Resource file has been created using the LabWindows interface editor and the executable file has been built by compiling and linking all of the C source and header files.

In the diagram above, an arrow indicates that a module depends on the routines in another (for example, the module Converter.c requires routines in Conversions.h and Help.h).

The executable file is produced from the source file that shares its name, and any other files that are used by that module.  Therefore, the main module is Converter.c which consists mainly of callback functions used to respond to events generated by the user on the user interface.  Associated with Converter.c is its header file, Converter.h, which is automatically generated by LabWindows and provides the constants for the user interface.

4.2 Input File Formats Supported

· SRS (.dat extension)

Daresbury beam-line 16.4 energy dispersive Data (single and multiple spectra files).

· Argonne (extension increments from .001, etc…)

Energy dispersive data from Argonne University USA.

· MCA (.chn extension)

Binary data collected from Ortec MCA (multi channel analyser).

4.3 Output File Formats Supported

· Xfit/Koalariet (.dat extension)

Format suitable for use in the Xfit for Windows program.

· SRS (.dat extension)

Daresbury beam-line 16.4 energy dispersive data (single and multiple spectra files).

· CPI (.cpi extension)

Format suitable for use in the X-Plot program.

Conversion supported :

SRS

(

Xfit and CPI

Argonne
(

Xfit and CPI

MCA

(

SRS

4.4 Conversion Formats Supported

· Normal (*.dat extension)

· Energy (KeV) to D-Spacing (Angstrom) (*.xy, *.prn, *.txt extension)

X,Y non-interpolated

· Energy (KeV) to Two-Theta (degree) (*.xy, *.prn, *.txt extension)

X,Y non-interpolated

4.5 Converter.c

The module Converter.c is the most important in the program.  It consists mainly of callback functions that are used to respond to events generated on the user interface.

4.5.1 Global Variables

· mainpan, progresspan, aboutpan, xfitoptpan, srsoptpan, cpioptpan, warnpan, datepan

These variables hold the panel handles of all the panels used in the application.

· aboutpanopen, xfitoptopen, srsoptopen, cpioptopen, warnopen

Flags determining whether a panel has been loaded into memory and displayed.

1 if loaded into memory and displayed, 0 otherwise.

(Note that a panel’s open flag will still be set to 0 if the panel is loaded into memory but not displayed i.e. hidden.  The flag will be set to 1 only if the panel is displayed.  Once a panel has been loaded into memory, it remains there until the program has been terminated.)

· inputtype, outputtype, conversiontype

Variables to keep track of the input and output file formats currently selected by the user.  These are constants described in Converter.c.

The “inputtype” variable is altered :

When any input files have been successfully opened from the Open() function;

Set to NONE when any input files are removed using the MPRemoveAllCB callback function (by clicking on “Remove All” on the main panel).

The “outputtype” variable is altered :

When the user selects or deselects the output type using the “Select Output Format” toggle buttons on the main panel.

The “conversiontype” variable is altered:

When the user selects or deselects the conversion type using the “Conversion Format” toggle buttons on the main panel.

· cancel

Cancel flag – 1 if a cancel has been requested by the user when the ‘Cancel’ command button is clicked on from the progress panel, 0 otherwise.

Options :

All of the options for all of the different output file formats are stored as global variables.  They are all initialised at the start of the program in the function SetUpGlobals() and are altered when the “OK” command button is pressed on the various options panels, updating any option changes.

· xfit_sameasinput, xfit_singlecolumn, xfit_add1, xfit_nochange, xfit_aval, xfit_bval

· srs_singlefile, srs_multifile

· cpi_nochange, cpi_add1, cpi_wavelength, cpi_unknown, cpi_angle, cpi_avalue, cpi_bvalue, cpi_disvalue

· dspace_nochange, dspace_add1, dspace_header, dspace_noheader, dspace_avalue, dspace_bvalue, dspace_anglevalue

4.5.2 Non-Callback Functions

Most of the functions in this module are user interface callback functions, since this is the main module of an event-driven program.  However, there are a number of functions which are not callback functions.  The most notable is the main() function where the program flow begins.  The other non-callback functions are either involved with setting up the application or provide some utility during the running of the program.

Function : 

int main (int argc, char *argv[])

Parameters :
argc, argv : Program parameters passed from outside the program.  They are not used.

Returns : 

integer value, program termination status.

Calls : 

SetUpGlobals()

Description : 

Program flow begins here.  The main panel is loaded into memory and displayed.  A function called SetUpGlobals() is called from main to initialise the global variables. The user interface is then run which issues events to callback functions.

Function : 

void SetUpGlobals (void)

Parameters : 

None

Returns : 

Nothing

Called from : 

main() function at beginning of program execution.

Calls : 

Nothing

Description : 

Initialises all of the global variables in the program.

The flags determining whether a panel is open are all set to zero as no panels, other than the main panel, are loaded into memory at the start of program execution.

The input and output type flags, and the cancel flag, are set to zero.

All of the options for all of the different output formats are set to their defaults as specified in the Converter.uir file. 

Function : 

void Open (int opentype)

Parameters : 

int opentype – depending on which ‘Open’ menu callback called this function, the relevant input file type (constant specified in Converter.c) is passed.

Returns : 

Nothing

Called from : 

The various ‘Open’ menu callback functions :

MMOpenArgonne, MMOpenMCA, MMOpenSRS for example.

Calls : 

Nothing

Description : 

This function allows the user to select a number of files from a pop-up panel (provided by LabWindows).  Once the files have been opened they appear in a listbox on the user interface.  The filenames are allocated dynamically to an array of strings when they are selected by the user.  

The file extension is restricted to the particular input file format you wish to open.

If the user selects files of a different type than any files previously selected (currently in the listbox), the listbox is first cleared before inserting the new files.  Obviously, only one input file format can be selected at any one time.

The global ‘inputtype’ and a UI indicator are set, and the relevant output file type toggle buttons are hidden according to the input file(s) just opened.

If the newly opened input file is not compatible with a conversion to an already selected output file type, then all output file types are deselected and the global ‘outputtype’ and UI indicator are set to NONE.

Function : 

void Conversion (int inputtype, int outputtype)

Parameters :
int inputtype, int outputtype – When the ‘Convert’ callback function is activated (by clicking on the ‘Convert’ command button on the main panel), the input and output types (constants) requested by the user are passed as parameters.

Returns : 

Nothing

Called from : 

MPConvertCB (‘Convert’ callback function)

Calls : 

The relevant conversion procedure in Conversions.h.

Description : 

This function acts as a filter for determining which conversion procedure to call from Conversions.h.  The function is passed parameters (global variables “inputtype” and “outputtype”) which determine which input and output formats have been selected and calls the appropriate procedure.

This function also maintains an on-screen progress panel and the log file.

4.5.3 Main Panel Callback Functions

In this program, there are two events that are responded to on the main panel (excluding selection from menus) and other panels.  These events are :

· EVENT_COMMIT

Left mouse click – operates the control normally.

· EVENT_RIGHT_CLICK

Right mouse click – brings up a dialogue box with help information about the control.

NOTE : Callbacks can also be generated using the keyboard (typical Windows keys such as <TAB> <RETURN> <ALT> <CTRL>).

The following few callback sections describe the responses generated by the callback functions of all panels when an EVENT_COMMIT is detected.  The help information generated by an EVENT_RIGHT_CLICK have not been described.

A standard that I have adopted to name callback functions consists of the following abbreviations :

· MP

Main panel.

· MM
Main menu.

· PP

Progress panel.

· AP

About panel.

· CB

Command button.

· TB

Toggle button.

Function : 

MPConvertCB

Object : 

“Convert” command button on the main panel.

Response : 

When the “Convert” button is clicked on, a check is made to see whether any input type has been selected.  The program does this by checking the “inputtype” global variable.  Then, a check is made to see whether any of the files listed in the listbox have been check marked.  Then, a check is made to see whether the user has selected an output type.  Similarly, it does this by checking the “outputtype” global variable.  Error messages are displayed if any of these three checks fail.

If all three checks are OK, the function Conversion() is called and is passed the “inputtype” and “outputtype” global variables as parameters.

Function : 

MPOptionsCB

Object : 

“Options…” command button on the main panel.

Response : 

This command button performs the same function as selecting one of the output formats from the “Options” menu item on the main menu bar.

In order for this command button to be used properly, the user must first of all toggle one of the output format toggle buttons on the main panel (“Select Output format”).

According to the output format that has been selected by the user, the relevant options panel is loaded into memory and displayed by calling the callback functions on the “Options” menu item.

This function does not contain the code to do this; it instead calls the callback functions from the main menu options (MMXfitOpt for example).

Function : 

MPSelectAllCB

Object : 

“Select All” command button on the main panel.

Response : 

This function simply puts a check mark next to all of the files that the user has selected and inserted into the listbox.  When the user clicks on “Convert” from the main panel, only the filenames that have been checked will be converted.

Function : 

MPDeselectAllCB

Object : 

“Deselect All” command button on the main panel.

Response : 

This function removes the checkmarks (if any) from all of the files that the user has selected and inserted into the listbox.

Function : 

MPRemoveAllCB

Object : 

“Remove all” command button on the main panel.

Response : 

This function simply removes all of the files that the user has selected and inserted into the listbox.  When this is done, the global variable “inputtype” needs to be set to NONE and the indicator on the user interface must be set to show “None”.  Also, since there is no longer an input format selected, all of the output format toggle buttons can be undimmed (if any).

Function : 

MPResetCB

Object : 

“Reset” command button on the main panel.

Response : 

This function resets the present list box to display the opened files previously selected in order to do an another conversion if needed.

Function : 

MPQuitCB

Object : 

“Quit” command button on the main panel.

Response : 

Quits the program.  Before terminating the program, the user is asked to confirm the termination, and a check is made to see if any panels are open.  If any are open, they are closed.

4.5.4 Output Format Toggle Button Callbacks

The “Select Output Format” toggle button (on main panel) callbacks all share the same structure as follows :

If, after pressing the toggle button, the button is on :

1. Set the “outputtype” global variable and the indicator on the user interface to the appropriate value.

2. Deselect all other output format toggle buttons.

Else if, after pressing the toggle button, the button is off :

1. Set the “outputtype” global variable to NONE and the indicator on the user interface to “None”.

Function : 

MPXfitTB

Object : 

“Xfit” toggle button on the main panel.

Response : 

See above.

Function : 

MPSrsTB

Object : 

“SRS” toggle button on the main panel.

Response : 

See Above.

Function :

MPCpiTB

Object : 

“CPI” toggle button on the main panel.

Response : 

See above.

Function : 

MPNormalTB

Object : 

“Normal” toggle button on the main panel.

Response : 

See above.

Function : 

MPDspacingtTB

Object : 

“D-Spacing” toggle button on the main panel.

Response : 

See above.

Function : 

MPTwoThetaTB

Object : 

“Two-Theta” toggle button on the main panel.

Response : 

See above.

4.5.5 Main Menu Callback Functions

The main menu is the menu bar on the main panel.  It contains a number of options, some of which duplicate the functionality of the command buttons on the main panel.

The responses to the selection of these menu items are as follows :

Function : 

MMOpenArgonne

Menu Item : 

File -> Open -> Argonne(Uni) Format

Response : 

Calls the Open() function with the ARGONNE constant as a parameter.

Function : 

MMOpenMCA

Menu Item : 

File -> Open -> Ortec MCA Format

Response : 

Calls the Open() function with the MCA constant as a parameter.

Function : 

MMOpenSRS

Menu Item : 

File -> Open -> SRS Format

Response : 

Calls the Open() function with the SRS constant as a parameter.

Function : 

MMConvert

Menu Item : 

File -> Convert

Response : 

Calls the MPConvertCB callback function (same as clicking on the “Convert” command button on the main panel).

Function : 

MMPrintLogFile

Menu Item : 

File -> Print Log File

Response : 

A log file called “log.dat” is maintained by the program and should be in the project directory.  This log file contains a list of all of the conversions that have been made by the last conversion attempt.  This function sends the document to the printer.

Function : 

MMEnergyOpt

Menu Item : 

Options -> Xfit (Energy) Options…

Response : 

The Xfit options panel is loaded into memory (if it is not already loaded).  Then, all of the toggle buttons and other options on the panel are set using the global variables which hold the option values.  The panel is then displayed and the “xfitoptopen” flag is set to 1.

Function : 

MMSrsOpt

Menu Item : 

Options -> SRS Options…

Response : 

The SRS options panel is loaded into memory (if it is not already loaded).  Then, all of the toggle buttons and other options on the panel are set using the global variables which hold the option values.  The panel is then displayed and the “srsoptopen” flag is set to 1.

Function : 

MMCpiOpt

Menu Item : 

Options -> CPI Options…

Response : 

The CPI options panel is loaded into memory (if it is not already loaded).  Then, all of the toggle buttons and other options on the panel are set using the global variables which hold the option values.  The panel is then displayed and the “cpioptopen” flag is set to 1.

Function : 

MMDspaceOpt

Menu Item : 

Options -> Dspacing or Two-Theta Options…

Response : 

The Dspacing or Two-Theta options panel is loaded into memory (if it is not already loaded).  Then, all of the toggle buttons and other options on the panel are set using the global variables which hold the option values.  The panel is then displayed and the “dspoptopen” flag is set to 1.

Function : 

MMExtCol

Menu Item : 

Utility -> Extract Columns

Response : 

Function not yet implemented.

Function : 

MMOverview

Menu Item : 

Help -> Overview

Response : 

Displays a message popup panel containing information about the program.

Function : 

MMAbout

Menu Item : 

Help -> About

Response : 

Loads the about panel and displays it on the screen.  The panel contains information about the program.

Function : 

MMQuit

Menu Item : 

File -> Quit

Response : 

Calls the callback function MPQuitCB.  Same as clicking on the “Quit” command button on the main panel.

4.5.6 Options Panel Callback Functions

To set any options for any particular output format you need to first of all display the relevant options panel.  To do this, either click on Options from the main menu bar and select the desired output format, or click on an output format toggle button and then the “Options” command button on the main panel.

4.5.7 Xfit Options Panel Callback Functions

Function : 

XfitOptPanOK

Object : 

“OK” command button on the XFit options panel.

Response : 

When “OK” is pressed on an options panel, it sets the relevant option globals to their appropriate values depending on what the user has toggled on the options panel.  Then the panel is discarded (but still held in memory) and the “xfitoptopen” flag is set to 0.

Function : 

XfitOptPanCancel

Object : 

“Cancel” command button on the XFit options panel.

Response : 

When “Cancel” is pressed on an options panel, it simply discards the panel (but still holds it in memory) and sets the “xfitoptopen” flag to 0, without altering the option globals.

Function : 

XfitOptPanSameAsInTB

Object : 

“Same as Input” toggle button on the Xfit options panel.

Response : 

The option “Same as Input” is toggled with “Single Column” and “10 columns Output”.  This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

XfitOptPanSingColTB

Object : 

“Single Column” toggle button on the Xfit options panel.

Response : 

The option “Single Column” is toggled with “Same as Input” and “10 columns Output”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

XfitOptPanTenColTB

Object : 

“10 columns Output” toggle button on the Xfit options panel.

Response : 

The option “10 columns Output” is toggled with “Same as Input” and “Single Column”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

XfitOptPanAdd1TB

Object : 

“Add 1 to All Values” toggle button on the Xfit options panel.

Response : 

The option “Add 1 to All Values” is toggled with “No Change”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

XfitOptPanNoChangeTB

Object : 

“No Change” toggle button on the Xfit options panel.

Response : 

The option “No Change” is toggled with “Add 1 to All Values”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

4.5.8 SRS Options Panel Callback Functions

Function : 

SrsOptPanOK

Object : 

“OK” command button on the SRS options panel.

Response : 

When “OK” is pressed on an options panel, it sets the relevant option globals to their appropriate values depending on what the user has toggled on the options panel.  Then the panel is discarded (but still held in memory) and the “srsoptopen” flag is set to 0.

Function : 

SrsOptPanCancel

Object : 

“Cancel” command button on the SRS options panel.

Response : 

When “Cancel” is pressed on an options panel, it simply discards the panel (but still holds it in memory) and sets the “srsoptopen” flag to 0, without altering the option globals.

Function : 

SrsOptPanSingFileTB

Object : 

“Single File” toggle button on the SRS options panel.

Response : 

The option “Single File” is toggled with “Multiple Files”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

SrsOptPanMultFileTB

Object : 

“Multiple Files” toggle button on the SRS options panel.

Response : 

The option “Multiple Files” is toggled with “Single File”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

4.5.9 CPI Options Panel Callback Functions

Function : 

CpiOptPanOK

Object : 

“OK” command button on the CPI options panel.

Response : 

When “OK” is pressed on an options panel, it sets the relevant option globals to their appropriate values depending on what the user has toggled on the options panel. 

Also the function checks that the step, start and wavelength or angle of detector values are correct.

Then the panel is discarded (but still held in memory) and the “cpioptopen” flag is set to 0.

Function : 

CpiOptPanCancel

Object : 

“Cancel” command button on the CPI options panel.

Response : 

When “Cancel” is pressed on an options panel, it simply discards the panel (but still holds it in memory) and sets the “cpioptopen” flag to 0, without altering the option globals.

Function : 

CpiOptPanAdd1TB

Object : 

“Add 1 to All Values” toggle button on the CPI options panel.

Response : 

The option “Add 1 to All Values” is toggled with “No Change”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

CpiOptPanNoChangeTB

Object : 

“No Change” toggle button on the CPI options panel.

Response : 

The option “No Change” is toggled with “Add 1 to All Values”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

CpiOptPanWave

Object : 

“Wavelength” toggle button on the CPI options panel.

Response : 

The option “Wavelength” is toggled with “Angle of detector” and “Not known”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

CpiOptPanAngle

Object : 

“Angle of detector” toggle button on the CPI options panel.

Response : 

The option “Angle of detector” is toggled with “Wavelength” and “Not known”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

CpiOptPanNotKnown

Object : 

“Not known” toggle button on the CPI options panel.

Response : 

The option “Not known” is toggled with “Wavelength” and “Angle of detector”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

When “Not known” is toggled it is not possible to change the wavelength or the angle of detector value. As default the not known value has been set to 1.

4.5.10  Dspace Options Panel Callback Functions

Function : 

DspaceOptPanOK

Object : 

“OK” command button on the Dspacing or Two-Theta options panel.

Response : 

When “OK” is pressed on an options panel, it sets the relevant option globals to their appropriate values depending on what the user has toggled on the options panel.  Then the panel is discarded (but still held in memory) and the “dspoptopen” flag is set to 0.

Function : 

DspaceOptPanCancel

Object : 

“Cancel” command button on the Dspacing or Two-Theta options panel.

Response : 

When “Cancel” is pressed on an options panel, it simply discards the panel (but still holds it in memory) and sets the “dspoptopen” flag to 0, without altering the option globals.

Function : 

DspaceOptPanAdd1TB

Object : 

“Add 1 to All Values” toggle button on the Dspacing or Two-Theta options panel.

Response : 

The option “Add 1 to All Values” is toggled with “No Change”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

DspaceOptPanNoChangeTB

Object : 

“No Change” toggle button on the Dspacing or Two-Theta options panel.

Response : 

The option “No Change” is toggled with “Add 1 to All Values”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

DspaceOptPanHeaderTB

Object : 

“With header” toggle button on the Dspacing or Two-Theta options panel.

Response : 

The option “with header” is toggled with “without header”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

Function : 

DspaceOptPanNoHeaderTB

Object : 

“Without header” toggle button on the Dspacing or Two-Theta options panel.

Response : 

The option “without header” is toggled with “with header”. This function simply switches between the choices.  When the toggle button is pressed and is on, then untoggle any alternatives.  When the toggle button is pressed and is off, then toggle any alternatives.

4.5.11 Progress Panel Callback Functions

Function : 

PPCancel

Object : 

“Cancel” command button on the progress panel.

Response : 

All this callback function does is simply set the global flag “cancel” to 1 to indicate that the user has requested a cancellation of the conversion in progress.  The “cancel” flag is checked in the Conversion() procedure in “Converter.c” and some of the conversion procedures in “Conversions.h”.

4.5.12 About Panel Callback Functions

Function : 

APOKCB

Object : 

“OK” command button on the about panel.

Response : 

This function simply closes the about panel, removes it from memory and sets the “aboutpanopen” flag to 0.

4.6 Conversions.c

This file contains the routines for converting files to and from various formats. All of these conversion procedures are called from the switch statement in the Conversion() function in “Converter.c”.  “Conversions.c” contains the following functions :

· ARGONNEtoXFIT()

· ARGONNEtoCPI()

· MCAtoSRS()

· SRStoXFIT()

· SRStoCPI()

· RebinXfitInput()

· SRStoDSPACING()

· SRStoTWOTHETA()

· RebinArgonneInput()

· ARGONNEtoDSPACING()

· ARGONNEtoTWOTHETA()

4.6.1 Imported Variables

Because all of the conversion functions have different methods of automatically choosing output file names, the progress panel needs to be accessed from these routines in order to be updated, and cannot be accessed from the Conversion() function.  Therefore also, the log file needs to be updated from these routines.  In order to access these external variables they must be imported from the “Converter.c”  module.  The external variables imported are as follows :

Imported Variable
Description

extern int progresspan
Progress panel handle in order to update the progress.

extern int cancel
Cancel flag in order to update a cancel event.

extern FILE *logfile
Pointer to log file in order to update it.

NOTE : All of the options for all of the different types of conversion need to be imported also.

What follows is a description of the conversion functions in more detail :

ARGONNEtoXFIT()

Function :

void ARGONNEtoXFIT (void)

Calls :
CheckArgonneFile()

Description :

Converts Argonne (University) data files to Xfit data files.

This function begins by calling CheckArgonneFile() to position the file pointer at the beginning of the data.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory.  This will be where the directory where the output data files are stored.  The function has a method of choosing the output filename from the input filename.  The Argonne data files are usually produced every minute during a run.  Therefore, the filenames will usually be generated as follows :

run_15.001, run_15.002, run_15.003, etc…

Because Xfit needs a .dat file extension, the output filename will be named as follows:

run15_001.dat, run15_002.dat, run_15.003.dat, etc…

E.g. An input file C:\Data\run_15.001 and a selected output directory C:\Output will produce an output file C:\Output\run15_001.dat.

All Argonne data files are in single column format, therefore, when converted to Xfit format, they will still be in single column format.

The Xfit header information is inserted at the top of the output file after conversion.

4.6.2 ARGONNEtoCPI()

Function :

void ARGONNEtoCPI (void)

Calls :
CheckArgonneFile(), FindDate()

Description :

Converts Argonne (University) data files to CPI data files.

This function begins by calling CheckArgonneFile() to position the file pointer at the beginning of the data.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory.  This will be where the directory where the output data files are stored.  The function has a method of choosing the output filename from the input filename.  The Argonne data files are usually produced every minute during a run.  Therefore, the filenames will usually be generated as follows :

run_15.001, run_15.002, run_15.003, etc…

Because CPI needs a .cpi file extension, the output filename will be named as follows:

run15_001.cpi, run15_002.cpi, run_15.003.cpi, etc…

E.g. An input file C:\Data\run_15.001 and a selected output directory C:\Output will produce an output file C:\Output\run15_001.cpi.

All Argonne data files are in single column format, therefore, when converted to CPI format, they will still be in single column format.

This function calls FindDate() to position the file pointer at the beginning of the string containing the date in the Argonne file. The user will have to choose between the date of the day and the date contained in the Argonne data file.

The CPI header information is inserted at the top of the output file after conversion.

4.6.3 MCAtoSRS()

Function :

void MCAtoSRS (void)

Calls :
Nothing.

Description :

Converts binary files of Ortec MCA format to Daresbury SRS data files.

This function has two methods of automatically choosing output file names depending on which option has been chosen from the “SRS Options” panel.  If the option chosen is “Single Output” file, all of the converted input files will be appended into one single output file.  This filename will explicitly be requested by the user before conversion.  If the option chosen is “Multiple Output” files, all of the converted input files will have their own corresponding output file.  Before conversion, the user will be asked to select an output directory which is where the output files will be sent.  The output files will have the same name as the input files except with a .dat file extension as opposed to .chn for the Ortec MCA data files.

The output SRS data files will comply with the Daresbury standards by having “SPECTRUM END” and “END OF DATA” flag strings.

A header and a footer will also be written to the output files, or to each spectra in the output files if the option chosen was “Single Output”.

4.6.4 SRStoXFIT()

Function :

void SRStoXFIT (void)

Calls :
CheckSrsFile(), FindData() and SingOrMult().

Description :

Converts files of Daresbury SRS format to Xfit data files.

This function begins by calling the CheckSrsFile() function to position the file pointer at the beginning of the data.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory. The function has a method of choosing the output filename from the input filename and the spectrum number.  The fact that Daresbury SRS data files may contain a single spectrum or multiple spectra must be taken into account when automatically choosing output filenames. 

Within the output directory selected by the user, is created another sub-directory of the same name as input file.  Then, within this directory, the output filenames are created with the number of the spectrum as the filename.  A .dat file extension is then added to the end.

e.g. A multiple spectra input file C:\Data\r88888.dat and a selected output directory C:\Output would produce output data files as follows :

C:\Output\r88888\00001.dat

C:\Output\r88888\00002.dat

C:\Output\r88888\00003.dat

Etc…

The beginning of a spectrum’s data is signified by “SPECTRUM n” where n is the number of the spectrum.  The end of a spectrum’s data is signified by “SPECTRUM END”.  The end of the whole file is signified by “END OF DATA”.  This conversion routine does not look for these string flags, so in some cases where these flags have been omitted, the function will still convert the files properly.

When converting multiple spectra files, this function calls FindData() to skip the headers in between spectra.

Daresbury SRS data files are usually in column format.  Depending on which option is chosen from the Xfit Options panel, the output file will either be in the same column format as the input file, single column or ten columns.

The Xfit header information is inserted at the top of the output file after conversion.

Thanks to the function SingOrMult(), the function will prompt to the user whether the files he has chosen have been converted as a single file or a multiple file.

4.6.5 SRStoCPI()

Function :

void SRStoCPI (void)

Calls :
CheckSrsFile(), FindData() and SingOrMult().

Description :

Converts files of Daresbury SRS format to CPI data files.

This function begins by calling the CheckSrsFile() function to position the file pointer at the beginning of the data. The function automatically chooses output filenames by, first of all, asking the user to select an output directory. The function has a method of choosing the output filename from the input filename and the spectrum number. The fact that Daresbury SRS data files may contain a single spectrum or multiple spectra must be taken into account when automatically choosing output filenames.

SingOrMult() will determine the output directory. If the SRS files are single file then the converted files will be stored in the same directory. If the SRS files are multiple files then the converted files will be created in another sub-directory of the same name as input file.  Then, within this directory, the output filenames are created with the number of the spectrum as the filename.  A .cpi file extension is then added to the end.

e.g. A single spectrum input file C:\Data\r88888.dat would produce output data files as follows :

C:\Data\r88888.cpi

And a multiple spectra input file C:\Data\r99999.dat would produce output data files as follows :

C:\Data\r99999\00001.cpi

C:\Data\r99999\00002.cpi

Etc…

The beginning of a spectrum’s data is signified by “SPECTRUM n” where n is the number of the spectrum.  The end of a spectrum’s data is signified by “SPECTRUM END”.  The end of the whole file is signified by “END OF DATA”.  This conversion routine does not look for these string flags, so in some cases where these flags have been omitted, the function will still convert the files properly.

When converting multiple spectra files, this function calls FindData() to skip the headers in between spectra.

The CPI header information is inserted at the top of the output file after conversion.

Thanks to the function SingOrMult(), the function will prompt to the user whether the files he has chosen have been converted as a single file or a multiple file.

4.6.6 RebinXfitInput()

Function :

void RebinXfitInput (void)

Calls :
CheckSrsFile.

Description :

Rebins files of Daresbury SRS format.

This function rebins the SRS data from two datapoints to one or four datapoints to one and writes the result in a temporary file. This temporary file will be open by the function SRStoDSPACING() or SRStoTWOTHETA().

This function begins by calling the CheckSrsFile() function to position the file pointer at the beginning of the data. The function automatically chooses output filenames by, first of all, asking the user to select an output directory. The function has a method of choosing the output filename from the input filename and the spectrum number. The fact that Daresbury SRS data files may contain a single spectrum or multiple spectra must be taken into account when automatically choosing output filenames.

At the moment, the SRS data files that may contain multiple spectra will rebin only the first spectrum of those file.



4.6.7 SRStoDSPACING()

Function :

void SRStoDSPACING (void)

Calls :
CheckSrsFile and SingOrMult().

Description :

Converts files of Daresbury SRS format to Dspacing data files.

This function begins by calling the temporary file that it has been created thanks to the function RebinXfitInput().

This function will calculate the values of the Dspacing for each value of the Energy. 

The function automatically chooses output filenames by, first of all, asking the user to select an output directory. The function has a method of choosing the output filename from the input filename. 

Within the output directory selected by the user, is created another sub-directory of the same name as input file.  Then, within this directory, the output filenames are created with the number of the spectrum as the filename.  A file extension is then added to the end depending of the menu item extension selection:

e.g. C:\DATA\R88888\00001.xy

C:\DATA\R88888\00001.prn

C:\DATA\R88888\00001.txt

Depending on which option is chosen from the D-Spacing or Two-Theta Options panel, the Dspacing header information will either be inserted at the top of the output file after conversion.

Thanks to the function SingOrMult(), the function will prompt to the user whether the files he has chosen have been converted as a single file or a multiple file.

4.6.8 SRStoTWOTHETA()

Function :

void SRStoTWOTHETA (void)

Calls :
CheckSrsFile and SingOrMult().

Description :

Converts files of Daresbury SRS format to Two-Theta data files.

This function begins by calling the temporary file that it has been created thanks to the function RebinXfitInput().

This function will calculate the values of the Two-Theta for each value of the Energy.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory. The function has a method of choosing the output filename from the input filename. 

Within the output directory selected by the user, is created another sub-directory of the same name as input file.  Then, within this directory, the output filenames are created with the number of the spectrum as the filename.  A file extension is then added to the end depending of the menu item extension selection

e.g. C:\DATA\R88888\00001.xy

C:\DATA\R88888\00001.prn

C:\DATA\R88888\00001.txt

Depending on which option is chosen from the D-Spacing or Two-Theta Options panel, the Two-Theta header information will either be inserted at the top of the output file after conversion.

Thanks to the function SingOrMult(), the function will prompt to the user whether the files he has chosen have been converted as a single file or a multiple file.

4.6.9  RebinArgonneInput()

Function :

void RebinArgonneInput (void)

Calls :
CheckArgonneFile().

Description :

Rebins Argonne (University) data files.

This function rebins the Argonne data from two datapoints to one or four datapoints to one and writes the result in a temporary file. This temporary file will be open by the function ARGONNEtoDSPACING() or ARGONNEtoTWOTHETA().

This function begins by calling CheckArgonneFile() to position the file pointer at the beginning of the data.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory.  This will be where the directory where the output data files is stored.  The function has a method of choosing the output filename from the input filename.  The Argonne data files are usually produced every minute during a run.  Therefore, the filenames will usually be generated as follows :

run_15.001, run_15.002, run_15.003, etc…

All Argonne data files are in single column format, therefore, when converted to Xfit format, they will still be in single column format.

4.6.10  ARGONNEtoDSPACING()

Function :

void ARGONNEtoDSPACING (void)

Calls :
None..

Description :

Converts Argonne (University) data files to Dspacing data files.

This function begins by calling the temporary file that it has been created thanks to the function RebinArgonneInput().

This function will calculate the values of the Dspacing for each value of the Energy.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory.  This will be where the directory where the output data files is stored.  The function has a method of choosing the output filename from the input filename.  The Argonne data files are usually produced every minute during a run.  Therefore, the filenames will usually be generated as follows :

run_15.001, run_15.002, run_15.003, etc…

Depending on the menu item extension selection, a file extension will be added and the output filename will be named as follows:

run15_001.xy, run15_001.prn or run_15.001.txt, etc…

E.g. An input file C:\Data\run_15.001 and a selected output directory C:\Output will produce an output file C:\Output\run15_001.xy.

All Argonne data files are in single column format, therefore, when converted to Dspacing format, they will still be in single column format.

Depending on which option is chosen from the D-Spacing or Two-Theta Options panel, the Dspacing header information will either be inserted at the top of the output file after conversion or not.

4.6.11  ARGONNEtoTWOTHETA()

Function :

void ARGONNEtoTWOTHETA (void)

Calls :
None.

Converts Argonne (University) data files to Two-Theta data files.

This function begins by calling the temporary file that it has been created thanks to the function RebinArgonneInput().

This function will calculate the values of the Two-Theta for each value of the Energy.

The function automatically chooses output filenames by, first of all, asking the user to select an output directory.  This will be where the directory where the output data files are stored.  The function has a method of choosing the output filename from the input filename.  The Argonne data files are usually produced every minute during a run.  Therefore, the filenames will usually be generated as follows :

run_15.001, run_15.002, run_15.003, etc…

Depending on the menu item extension selection, a file extension will be added and the output filename will be named as follows:

run15_001.xy, run15_001.prn or run_15.001.txt, etc…

E.g. An input file C:\Data\run_15.001 and a selected output directory C:\Output will produce an output file C:\Output\run15_001.xy.

All Argonne data files are in single column format, therefore, when converted to Dspacing format, they will still be in single column format.

Depending on which option is chosen from the D-Spacing or Two-Theta Options panel, the Two-Theta header information will either be inserted at the top of the output file after conversion or not.

4.7 Tools.c

This module contains certain tools and utilities that are used in the program at various stages.  The file consists of the following functions :

· CheckSrsFile()

· CheckArgonneFile()

· CheckCancel()

· FindData()

· SingOrMult()

· FindDate()

The functions in more detail :

4.7.1 CheckSrsFile()

Function : 

FILE *CheckSrsFile (char *filename, int *columns)

Parameters : 

char *filename – This is the filename of the input file to be converted.

int *columns – integer value representing the number of columns of data in the file.  Passed by reference.  Null can be passed if this information is not needed.

Returns : 

FILE * - The function returns a pointer to the opened file positioned at the point where the data begins.  The function closes the file and returns if the file contains no numerical data values.

Called From : 

SRS conversion routines in “Conversions.h”.

Calls : 

FindData()

Description : 

This function is used to check an SRS data file before converting.  The function examines the file and looks for numerical data values (NOTE : The function looks for a data value as the first character of a line, ignoring any white space).  First of all the function opens the file with the specified file name and begins to look for data, recording the file position as it searches.  When the function encounters any data it resets the file position to the beginning of the data line and returns a pointer to the file.  The number of columns in the file can also be calculated (if required) by passing an integer value by reference.

4.7.2 CheckArgonneFile()

Function : 

FILE *CheckArgonneFile (char *filename)

Parameters : 

char *filename – This is the filename of the input file to be converted.

Returns : 

FILE * - The function returns a pointer to the opened file positioned at the point where the data begins.  NULL is returned if the file cannot be opened or if the file contains no data values.

Called From : 

Argonne conversion routines in “Conversions.h”.

Calls : 

Nothing.

Description : 

This function is used to check an Argonne data file before converting.  The function examines the file and looks for a “DATA:” string.  This is used to signify the start of the data.  First of all the function opens the file with the specified file name and begins to look for the string, recording the file position as it searches.  When the function encounters the string, it returns a pointer to the file.

4.7.3 CheckCancel()

Function : 

int CheckCancel()

Parameters : 

None.

Returns : 

int – 1 if the user has requested and verified a cancellation, 0 otherwise.

Called From : 

All of the conversion routines in “Conversions.h”.

Calls : 

Nothing.

Description : 

This function is used to check whether or not the user has requested a cancellation by clicking on “Cancel” from the progress panel.  It uses a LabWindows function called ProcessSystemEvents() to detect whether the user has requested a cancellation.  This call is required because when the program is stuck in a callback function, any user interface or system events will not be processed.  If a cancellation has been detected, the user is asked to verify the cancellation, and if verified, 1 is returned.  Otherwise, 0 is returned.

FindData()

Function : 

FILE *FindData(FILE *fptr)

Parameters : 

FILE *fptr – Pointer to an opened file.

Returns : 

A file pointer position at the beginning of numeric data. If no numerical data can be found, the function returns NULL.

Called From : 

Certain conversion routines in “Conversions.h”.

Calls : 

Nothing.

Description : 

Takes a file pointer as its parameter and reads in lines from that file until a digit is found as the first non-whitespace character of that line.  It is used for distinguishing header information from data.

4.7.4 SingOrMult()

Function : 

FILE *SingOrMult (char *filename)

Parameters : 

char *filename – This is the filename of the input file to be converted.

Returns : 

1 is the file contains more than one time the string "SPECTRUM END" indicating that the file is a multiple file. 

NULL is returned if the file cannot be opened or if the file contains no data values.

Called From : 

SRStoXFIT and SRStoCPI conversion routines in “Conversions.h”.

Calls : 

Nothing.

Description : 

This function is used to check a SRS data file before converting.  The function examines the file and looks for a “SPECTRUM END” string.  This is used to count if the string was found more than once.  First of all, the function opens the file with the specified file name and begins to look for the string, recording the number of times the string was found.  When the function encounters the string twice, it returns 1.

4.7.5 FindDate()

Function : 

FILE *FindDate (char *filename)

Parameters : 

char *filename – This is the filename of the input file to be converted.

Returns : 

FILE * - The function returns a pointer to the opened file positioned at the point where the date begins.  NULL is returned if the file cannot be opened or if the file contains no data values.

Called From : 

ARGONNEtoCPI conversion routines in “Conversions.h”.

Calls : 

Nothing.

Description : 

This function is used to check an Argonne data file before converting.  The function examines the file and looks for a “VERSION:” string.  This is used to signify the start of the date.  First of all, the function opens the file with the specified file name and begins to look for the string, recording the file position as it searches.  When the function encounters the string, it returns a pointer to the file.

4.8 Help.h

The header file “Help.h” simply contains string constants consisting of help information relevant to a particular command button or other object.  The are all used in object callback functions generated by right-clicking with the mouse on most objects.  The help text appears on a message popup panel on the screen.

5 Appendix : File Formats

File Type : Argonne (University)

ASCII text file.

File extension : data is collected at intervals (e.g. one data file per minute), so the file extension reflects the particular increment of data collection.  For example, run15.001, run15.002, run15.003, etc…

Example :

VERSION:    3.0

DATE:       Wed Jan 21 21:57:54 1998

CHANNELS:           2048

ROIS:                  2

REAL_TIME:        130.390

LIVE_TIME:        120.000

CAL_OFFSET:     -0.281349

CAL_SLOPE:      0.0749050

CAL_QUAD:         0.00000

TWO_THETA:        3.50000

ROI_0_LEFT:           626

ROI_0_RIGHT:          702

ROI_0_LABEL:  peak1

ROI_1_LEFT:           747

ROI_1_RIGHT:          802

ROI_1_LABEL:  peak2

DATA: 

0

0

0

0

0

0

0

0

0

0

0

0

0

1

1

1

1

2

etc…

Format :
Explanation :

Header
Any line that does not begin with a numerical value is considered to be header information.

“DATA:”
The beginning of the data is indicated by a “DATA:” string.

Data
The format of the data in these files is simply single spectrum in single column format. There is nothing to indicate the end of the data (apart from the end of the file).

File Type : SRS

ASCII text file.

File extension : (*.dat)

Example :

&SRS

 SRSRUN=28953,SRSDAT=971204,SRSTIM=144951,

 SRSSTN='W164',SRSPRJ='POWDERDF',SRSEXP='12345432',

 SRSTLE='Cu dial source top                                          ',

 SRSCN1='        ',SRSCN2='        ',SRSCN3='        ',

 &END

 Calib A with error  0.0000  0.0000

 Calib B with error 1.000000 0.000000

 SPECTRUM    1

   Accumulation Time for Data =    300.000 Seconds

  Current Temp             0.0000

  Set Point                0.0000

  Active segment           0.0000

  Active program           0.0000

  Program Elapsed time     0.0000

  Time parameters read  TEMP/TIME DISABLED

  DEDS time stamp       00-AUG-0000 00:00:00.00

        3.       0.       0.       0.       2.       0.       0.       1.

        0.       0.       1.       0.       0.       0.       0.       0.

        1.       0.       1.       0.       0.       0.       0.       1.

        0.       0.       1.       0.       0.       0.       0.       1.

etc…..

 SPECTRUM END

 END OF DATA

Format :
Explanation :

Header
Any line that does not begin with a numerical value is considered to be header information.

“SPECTRUM n”
Contained inside the header information is a “SPECTRUM n” string where n is the number of that particular spectrum.  This string indicates that the following data is spectrum n.  With multiple spectra SRS data files, the first spectrum is assumed to be 1 and the following spectra are all incremented by 1.

Data
Data values are usually in column format (although single column input data will not cause any problems).  All data values are separated by white space. There is nothing to indicate the end of the data (apart from the end of the file).

“SPECTRUM END”
The end of the data for a particular spectrum is indicated by a “SPECTRUM END” string.

“END OF DATA”
The end of all data in the data file (single or multiple spectra) is indicated by a “END OF DATA” string.

File Type : Xfit

ASCII text file.

File extension : (*.dat)

Example :

1.2345678900
1.9876543210
7933.9629630010

2197
3060
3644
3666
3156
2408
1441
785


345
147
58
40
23
16
18
16


19
34
27
28
52
53
76
134


206
422
543
590
685
587
460
309


164
96
53
17
9
9
7
6


4
12
11
9
6
5
7
6

8
8
11
3
6
5
3
6


4
6
8
6
3
7
11
4


3
4
5
5
7
7
9
8


7
6
8
6
7
8
6
8


5
4
5
5
2
7
4
5


3
10
4
5
6
4
5
3


4
3
4
5
4
3
7
2


5
8
3
4
3
2
4
3


6
3
5
3
1
2
5
5


5
4
5
5
5
2
3
3


1
3
7
5
7
5
2
3


3
2
4
7
3
5
4
3

etc…

Format :
Explanation :

5 lines of header
This is header information used by Xfit and can be blank.

Start, Step and Stop
This information, in the form of three floating-point values, is used by Xfit and must be on the 5th line of the header information.  The “Start” is the initial value of the angle, energy or channel.  The “Step” is the value by which every count is incremented.  The “Stop” value is generated from the “Start” and “Step” values using the equation :

(Step * (#values – 1)) + Start

Data
All data values are separated by white space and, depending on the options set in the program, can be written in single column format or as the same column format as the input file. There is nothing to indicate the end of the data (apart from the end of the file).

File Type : CPI

ASCII text file.

File extension : (*.cpi)

Example :

SIETRONICS XRD SCAN 

1.000000000

40.990000000

0.010000000

Xx

1.000000000

16-12-1998

1

Energy Dispersive Scan. 2-theta Angle of ED Detector =??????                                                                              

SCANDATA 

299

295

10

22

25

14

16

16

36

39

43

45

37

30

31

33

17

18

etc…

Format :
Explanation :

Header
This is header information used by CPI.

Start, Step and Stop
This information, in the form of three floating points values. The “Start” is the initial value of the angle, energy or channel.  The “Step” is the value by which every count is incremented.  The “Stop” value is generated from the “Start” and “Step” values using the equation :

(Step * (#values – 1)) + Start

Data
The format of the data in these files is simply single spectrum in single column format. There is nothing to indicate the end of the data.

File Type : DSPACING

ASCII text file.

File extension : (*.xy), (*.prn) or (*.txt)

Example :

1.0000000000
1.0000000000
1994.0000000000

71.125548
26

35.562774
22

23.708516
21

17.781387
37

14.225110
29

11.854258
20

10.160793
29

8.890694
19

7.902839
23

7.112555
25

6.465959
26

5.927129
39

5.471196
22

5.080396
26

4.741703
19

4.445347
24

etc…

Format :
Explanation :

Header
The converted file can either have or not a header.

Start, Step and Stop
This information, in the form of three floating points values. The “Start” is the initial value of the angle, energy or channel.  The “Step” is the value by which every count is incremented.  The “Stop” value is generated from the “Start” and “Step” values using the equation :

(Step * (#values – 1)) + Start

Data
The first column of the data in these files is the Dspacing value in Angstrom. The second column is the intensity in count. There is nothing to indicate the end of the data.

File Type : TWO-THETA

ASCII text file.

File extension : (*.xy), (*.prn) or (*.txt)

Example :

1.0000000000
1.0000000000
93.0000000000

1.241035
1

2.482216
1

3.723688
1

4.965598
1

6.208091
1

7.451316
1

8.695419
1

9.940550
1

11.186859
1

12.434497
1

13.683617
1

14.934373
1

16.186921
1

17.441419
1

18.698027
1

19.956906
1

21.218225
1

22.482153
1

23.748852
1

25.018509
1

26.291287
1

27.567384
1

28.846970
1

30.130238
1

etc…

Format :
Explanation :

Header
The converted file can either have or not a header.

Start, Step and Stop
This information, in the form of three floating points values. The “Start” is the initial value of the angle, energy or channel.  The “Step” is the value by which every count is incremented.  The “Stop” value is generated from the “Start” and “Step” values using the equation :

(Step * (#values – 1)) + Start

Data
The first column of the data in these files is the Two-Theta value in degree. The second column is the intensity in count. There is nothing to indicate the end of the data.
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